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IMS content
Book File Folder package Label Page
@ w @ w @ iy @ w @ v @

)
URL 2

3. PINUTIANNNISEAY URL Wiudavaaiideliadwmnasiutes Name

4. nsen URL figeensidenleslutes External URL
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@Juamﬂmwuswumsmaumsaauaaulau WBSC d13u813158 drinineuinsuazwaluladansaume UMINYIYFIUAER



18

5. Nans1gazLdgnfIasulgNgInuLenaIsusenau (013) nsaidAnasurglinaniaantAIadanung

Ao v . . . P vy 1 . . £
M fisiadie Display description on course page ielidaniulugos Description wanslumii

FIEINMTIIN * viangme) NM5UNTRYALNNNULMATEY AITONBIUNAINUAIE ***

}||A- |B | T | =E|E|E

% 5 © M = & W P P

& =i v o -
@ Adding a new URL to unw 2 N154 UoYAe
3 » Expand all

~ General

Name @ ‘ wwadFauiooulau 7 l

External URL @ ‘ https://arit.dusit.ac.th/2019/data service.html 4 :| Choose a link...

H
Description

5 TiinAnsrdumdeyaifunfunuudsisuioaulad

4 .
N1 www.arit.dusit.ac.th

Display description on course page @

6. Tuite Appearance MvuagULUUMILaAIHaNTWaLTEUsTaTINnTeulesly > adndy

(%
a

Save and return to course %4 Display asnsainuazukuulaes

¥ Appearance

Display (2 Automatic =

Embed description
Open

In pop-up

* Competencies

Automatic iuuan1siaselulf lnetananadutiavss URL Aviauleslineu wWamdn

. a & v o val o v oS v a
1A Link 7\]3LUWLUUVF‘UWLL‘W@QLiﬁ]uzmﬂ’]ﬂu@l’)LLWUWVU']W'NGUQ\‘]T]EJTU']

unasspuzoaulall

B ome 2 a4 = = = | 4 T
1'L‘1Hﬂﬁﬂ‘1&"lﬂ'uﬂ"l‘i’.lﬂ¥ﬁL'WJ-.IL'FIS-J’EI"IH LLW'E‘IQL?HHEEIEH“Lﬂu
&) . :

U1 www.arit.dusit.ac.th

Click https://arit.dusit.ac.th/2019/data servicehtml link to open resource.

& .
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N159AN13Y0YA

Dashboard My courses mdnn1Itaya Uil 2 nrsategutoya unanieuiaaulmi
wrdasausaulad @~
= AARIT
SDU DISCOVERY SERVICE

TiuviAAY

#ARIT

UNENUDHAYDINVIINYIAY

In pop-up fvuansiUadunt pop-up wihadluedn 1 i
%g WBSC'LMS BT ww3ssiinAus - Google Chrome
&+

@ aritdusitacth/2019/data_service html

ZARIT
+ @ nsrtugniogn 2

Mark as done

wnarslsznauuni 2 nisaseguteya

SDU DISCOVERY SERVICE

FiuviFAIAY
+ e undsfeuiaoulad 7

Mark as done

TiinAnwAumdayafnfivannumasiousd

4 2
M www.arit. dusit.ac.th
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msuuulaenasadluntingedv aunsavinlasutunausasa Uil

1. nuthsedsn aelavite Topic Aan Add an activity or resource

+

UN¥ 2 N5ASNgIUTIYA ~

1

b~

(® Add an activity or resource

Edit -

2. @anukau Resource > AanLaen File

Starred AlL

®

Book

]

3. INNUIRNG

Activities Resources
File Folder

IMS content
package

(< @

Label Page

File Wiudavaaivalwaenaisiutes Name

4. nsBNI8ATLIYAMBSUNELNgINULENA1SUSENU (91T)
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5. pAndeniaSesnuiy M fAvde Display description on course page wiielidaainulutes

Description waasluntins1e3 v meIunsn

6. adngnAsATLaLY File

* General

MName

Description

Select file

® Adding a new File to UNT 2 ﬂﬂ?ﬁfmﬂu%’a;ﬂa@
3

@ ‘ﬂ"l“iﬁ%ﬁdgﬁ_'lu'ﬁ{llgﬂ LJ

¥ Expand all

1(|A~ | B | T = | =

wongsUszneuuni 2 n1sainegudoua

Display description on course page @

g B

® Files

o=

Maximum size for new files: 50MB

You can drag and drop files here to add them.
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AU Choose File > LHanlwdnsainisunsnlusedsn > Aanu Open

File picker

[ Embedded files

Th Server files

Attachment
Th Recent files

Save as
& URL downloader

Choose File

No file chosen
#a Upload a file

Th Private files

i : Author
P Wikimedia

‘ LT3N duRER
Th Content bank

Organize « New folder =~ 1 @
A E . A
s CQuick access = <
: : wanlwa |
I Desktop - 030,jpg 031.jpg Pg
; Downloads - é
|‘:E'] Documents -
A =
=] Pictures * § .o
éu L
@ OneDrive - Personal : =
033.jpg AEAT G Open
P N e Hagm.pdf "
nelrive - Snan Nuosit | lnivers =
File name: v| | AlFiles () -
Open Cancel
AanYu Upload this file
File picker X
th Server files 2 ==
th Recent files
ATk Attachment
4 Upload a file . ’
msasegutaya.pdf
& URL downloader
Save as
T Private files ‘ ‘
) Wikimedia
Th Content bank i
15730 ATURER ‘
8
Choose licence @ ’ J
‘ All rights reserved y V‘
7
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Maxirnum size for new files:

“ . - ¢ ' . a Save and retum to course
9. ¥elnduazviinvatlndazuandludes Select files > adnUy

22

Unlimited

Select files

e e
B Files

s

MsasNg...

» Competencies

+ MsATNgUTOYa &

Mark as done

o 5 3
whaEnsUsEnauuni 2 ﬂﬂ‘éﬁi?&ﬁ"lu'ﬂﬂﬂdﬂ

= Py 2 Edit =
* unil 2 N1sasegIudeya 2 |
Edit =

n1sasaiianisngdyn Tuguuwuu Book
msaailemaertuzuiuy Book Wunisdnnsillemitanansaglugluuuniinenaisus

azuiile ansavilaautuneunssiolUl
Nt nelsiade Topic AAN Add an activity or resource

1

Edit -

1.
+ = v o
unn 2 m‘sﬁmagmﬂuaga & Z/
1\ Add an activity or resource
A a A
2. L@9nuau Resource > AaNLaan Book
Add an activity or resource X
Search
All Activities Resources
® ()
2 IMS content
Book Folder package Label Page
® @ ® @ @ @
diininguimauazimalulagansauna unIveduaIunan

flanisldauszuumsissunisaeuesulal WBSC dwmsuenansd
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[
Y

3. fiade Book luget Name warldsieazidunves Resource Tutas Description

@ Adding a new Book to “U‘Wﬁ 1 nskgaulusunsy Microsoft Excel®

» Expand all
- General
Name @ | msdmivdeya |
Destaiption 1A B I |= &= % %

© @ W ¢ W™ P e

4. @enive Appearance

¥ Appearance

Chapter formatting @ Numbers *

Style of navigation ) Images

3
II1 » IIP

O Custom titles @

Chapter formatting: fMmuazUkUUYeYe
Style of navigation: fiMuuAFULUUYBINTUINA
Custom titles: nMsuansToURsRIUluntn Book

- nyaildmdniden O Custom titles azuanstiovasiadaluniin Book

v a v
N133RALNUYBUA

Mark as dc . .
lsivdian Custom titles

at =] i
n1sdaudoyalu Excel

ﬂauaﬂuuﬂﬂl‘u Excel ‘ﬂ"ﬂﬂ‘ﬂﬂlﬂﬂ‘[ullﬂﬁﬂl'ﬂm‘ﬁ Workbook eml,ma“ Workbook 813
ﬂsynaumumﬂwauaﬂmwm Tmurvﬂ51wamaumammumaﬁun1'1 Worksheet

- nsdlmanden M custom titles azliunansdovesiidoluniin Book

MsIANUTaYA

Mark as done - .
taan Custom titles

?Jauawuuwnlu Excel ﬂmﬂﬂmnﬂu‘lwamiumw Workbook *msma.-.. Workbook 813
Usznauiiunsisdayanaloni Imumﬂwauauma“ﬂmumaﬁumw Worksheet
(nszA1¥¥iINTg) rswmmﬂsuumiuuwwayalu Excel lefiuniledo 1 tdu lunisdoay
Usznaufnowtinenanswanuuii Sy wildeuravidu3uuléiu Workbook daumii

=l uuq
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a Save and retumn to course
5. ANy

+ @ msdanuteya & Edit ~

Mark as done

- mssiuiannsneivnlu Book

1. @anLden Book Mas19ld

ol = L3 1 &
+ @ msimiuioya Edit ~
Mark as done

2. Tldemdsvenilomunusnyiges Chapter title wazldiilomlutes Content

et ~

1%

s @ W
AN99ALAUYBDUA
b ¥ Collapse all
¥ Editing chapter
Chapter title @ | msamdudoyalu Excel
Subchapter (Only available once the first chapter has been created)
Contnt Cllil[a~[Bl1| ===«

©_EEF_@ & W P wp

Yayantuiinlu Excel azgnamiululsadfisundn Workbook dausias Workbook a1a
Jsznaumunisiitouanaiunil lnenisdtayandaswiiniitisiiond: Worksheet

a Save changes
ASNYM

3
4. evimrusliazwanduntinenans

v @ o -
NMIANUYBUA &

Next: iM39nn"s Workbook »

at (=] Fd
nsdanuTayalu Excel

Tayafituiinlu Excel asgnimifululvaiGont Wt;nrkbookﬁ"au,ﬁiaz Workbook 813
Usznaviemsdayananevi TnenissdayausazwiniiidoFund Worksheet
(nszA1eYiinag) worawSsunstuiindayalu Excel linuwilsda 1 wu lumisdass
Usznaudwvienarsianewiin daiu wisdeudaziduFeuldiu Workbook daunii

s v a L o U s o w a a a a v a
@uamﬂézmuswumsl,saumsaauaaulau WBSC d13u813158 drinineuinsuazwaluladansaume UMINYIYFIUAER



Y

5. @nsannlude vsawlamlalnemdnfsuiles NTaUaIUNaoInIswi LY

Y

v o2 v {§} - Table of contents
A1F9ALNUVBUA
U g e i
« msdaiudeyal.. &
o MSAANS Wo.. g &
o msianms WodP~ &
. ]

w & ¥
ﬂ']iﬁ]ﬂkﬂU‘lJa%ﬁI‘u Excel

Joyaiituiinlu Excel segnimiululviafiSundt Workbook Gausiaz Workbook a1ausznoufmumsiedayavatonii Tnumisredaya

usazwthiliifafundt Worksheet (nseawiinis) s1o1awsunstuiindaualu Excel ldfvinisde 118u lunilsiaasdsznovinowin

U@+
0@+
U@+
U@ +

6. NI sas1ntermundaldlinaniiesesuny +

ﬂ"liﬁﬂlﬁu%aﬁ&a - Table of contents
+ msdaiivdeyal.. v ©

Mark as done + N159AMs Wo..~ v &

U@+
0®+
J® +

« Column (Aad.. ~ & [

o mMsiams Wo..~ v &
Next: r3dants Workbook »

ar =3 ¥
ﬂ']ii]ﬂLﬂU’U’z]%ﬁs[:‘L! Excel

Foyaiituiinlu Excel szgndmiiululwafiSundt Workbook Gausiaz Workbook a1aUsznoufumisieiayavatenii lasmisiedoya
usazwiniififfadund1 Worksheet (nssawsiinis) siorauBsumsiiuiindeyalu Excel ldfvmisde 118u lunisdassdsznoudowin

7. AUUUILLEAINIVINI DUNLS SUNDUNTN
8. 1dteiivaursauNsauNARINITasN
9. yndeamstmusliduidedsslvindn M Subchapter

10. Tdwilamn

a Save changes
11. Aanya

v e £ {{)} -
AM3RALAUVBUA
U 7 ¥ Collapse all
~ Editing chapter
wt = £ 8
. Asanfivdayalu Excel
Chapter title @ n159AN15 Workbook
[J Subchapter
Content, 5 1 A~ B I = liEEE %
9 10
© & @ & ™ @ wp
TuUsunsu Microsoft Excel tsuaiiouauaindiddasnssliihnisnsandaya g
annsoiliiinsaiemsdeya msinseideya nsadansml wuagnisduan Taw

o
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UNY 3 NISNBURNIIUY

NSUBUKUIBIY (Assignment)

lusguumsdamsiseunisasuesulatl WBSC aunsaimunsukuunisiaunineuie i

N

Seulanumullemnseuiiiuanluudazuniseuls lnegduuvaunsainludssgndldununisyiy

Qe X

DABULUUIRTIY (Essay) Msetedouwuuussenels deanunsavilanutunausseludl

1. nuthsednn aeldde Topic man Add an activity or resource

+ > 2 o 3 1
Unn 2 ANSEINZUVBYA » /
D Add an activity 6r resource

2. 1@0NUau Activities > Aanitden Assignment

Add an activity or resource b 4
‘ Search ‘
All Activities Resources
Assignment 2 Choice Database External tool Feedback
@ | e @ v @ v @ 7 @

3. nsenderuiusunugluges Assignment name

4. nsenA1au/nunueuninglutes Description lnganunsaldlaviatoninugunin Clip wson1s
41' v & s ‘:II A A
woulgslugauiuleddu o muleasuniuandlunauiniosils

5. pandenwaseanune M Display description on course page iouanI5I8ALLBEATDIIUT

v a
NBUMMWUIUWuqi']EJ'JSU']
~ General —
Assignment name (D | Aanawineumii 1 3
Description 1 A~ B | I =lEEE % S
© @ B ¢ W™ P wP
1. Tsunsululaswansdna ( Microsoft Excel ) iulusunsuusznnla
2. dwesnsldgunmluliasu ﬂa‘:ﬁﬂmﬁ@nﬁﬁ%{_‘
; 4
3. vl&au Microsoft Excel fiduiinudrasivuanala
4. Microsoft Excel vhaunwlaszuudianisle
5 5 w _ g 4w =

5. drwauneaululusunsy Microsoft Excel insvunnnoau =
Display description on course page @
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- nsdindnideniniesiang M Display description on course page

@® oo 1
Mark as done

1. Tsunsululaswansidniwa ( Microsoft Excel ) tlulusunsudsziavla
2. ddasmislasunmlulvdsu azdaadandrdsi Ribbon In

3. WA Microsoft Excel fitfufinudnaziivivanala

4. Microsoft Excel ¥iramumeldssuuuijuinisia
5

Frurumpaudlulusunsy Microsoft Excel fiviavunanaaauil

- nsdlldednidenieSaanune O Display description on course page

o o =i
ANDIUNIBUNN 1

1. Tsunsululaswaviddnea ( Microsoft Excel ) wulusunsudszuanla

2. awesansldgunmilulviaau ssdesdandrdai Ribbon Tn

5 o o 3. vlda1u Microsoft Excel ﬁ'ﬁuﬁnnﬁuwﬁmuaqﬂﬂ
@ Aowineunii 1

4. Microsoft Excel inumsldszuudfianisla

Fruauneduilulusunsy Microsoft Excel fisnuninodul

w

6. nsdienaskuvlunIsuaunuigauaiusawuuldlalutes Additional files Ingadntaan

anasd uagvihnsdentndiidesnis upload

Additional files (@ Maximum size for new files: Unlimited

0O HBH=m

-

You can drag and drop files here to add them.

7. Mvuesseznattunsdsnu luiide Availability lneadnidentu Enable
Allow submissions from: fvuadu anlunsiFudny
Due date: fvuaiu angavneveInsdsny ndaanifusseznaidmualinisdany
avannsadslsl uiazuanaiuiidudundimsuinauiu nanlumsdsnuiugae
Cut - off date: fyuafu awansiliamnsadanuiuiu naidmuelild Tnewih
edyaglivansdulinadanu (@unsaussyndldununisyindeasuiuudnte (Essay)

PsT9@RULUUUITENYLe)
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Remind me to grade by: Mviuaiu natbissuukdIsiougaaulun1snTvnueluiy
narfifualy
O Always show description:
- nsandniden M Always show description
wihs1eAmasiansuiseumnedus fuiiadng Assignment thy
- nsdlladednden O Always show description
wts1edrzuansuiinounnelagSudaua Ty raniitimualily Allow

submission from (a11150UsEENAlYUNUNITINToaaULULEnY (Essay) 138

UoaauwuuUIIEnele)
¥ Availability
Allow submissions from (@ 23 % December % 2022 % 09 % 00 # | EEnable
Due date @ 30 = December #% 2022 % 23 % 59 ¢ | [ Enable
Cut-off date @ 30 ¢ December # 2022 ¢ 23 % 59 ¢ | [ @ Enable
Remind me to grade by @ 9 3 January = 2023 % 10 # 00 ¢ | [# Enable

O Always show description (Z)

8. AwuagUiuuresnsaanuluiite Submission types

Submission types: ﬁmuﬂgmwumaﬁﬂﬁﬁwm
- Online text: @vuwuURunganUle

- File submissions: @t ukuukuulndle

'
a

Word limit: 1ile1dongunuunisdsnuuuufinideninuld Timuadiuiudigsgn
AoasiiinAnwIfium

Maximum number of uploaded files: Lfi’e]LaaﬂgﬂLLUUﬂ’]’iE’iN’MLLUULLUUlWé Tnuun
Fruauldgeanitanansa Upload ¢

Maximum submission size: Watdanguuuunsdsuuuuiuulig linmvuavuinves

IWldsugegainanunsa Upload la

Accepted file types: aidangukuunsdsuiuusuulng anansaimvun/ddaguiuy

Ya9lndnaansivdsle
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* Submission types
Submission types Online text@ @ File submissions(®
Word Limit @ | 500 Enable
Maximum number of uploaded files (2 2 %
Maximum submission size @ Site upload Limit (50MB) =
Accepted file types @ FREA N No selaction

9. ﬁ"l‘lﬂuﬂgﬂLLUU‘U@Qﬂ%LLuuﬁu‘ﬁQJ@‘UﬁN’lS Tukve Grade

Grade: fVUATEA/MUIBUDINITIAAL UL BASANUAAIAZLUULAL

- Grade to Pass: AMMUAAIALLUUANIUNUNNITUTLIY

* Grade

Grade \2)

Maximum grade

‘ 100 ‘

e

Grading method

Grade category @ Uncategorised #

Grade to pass @ ‘ ‘

.
10. manyu

11, uiseuvingazusnglunthsgidyn mugdiuunmnun

‘ Simple direct grading #

@ AMUNEUNT 1

Mark as done

1. Wsunsululasvanddnwa ( Microsoft Excel ) ilulUsunsutszianla
2. fdsmslagunmlulvdeu azdoadand dsii Ribbon 1

3. W& Microsoft Excel fitfufinudnaziiviuanaln

4. Microsoft Excel viarunslassuudijifnisia
h

Frununadudluliuswnsy Microsoft Excel dvanunnnaduil

v a

s v a L o U s o a a a v a
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UNfl 4 N15INNISHUUNAFDU

N133ANITUUUNAFDUTTUUNISIUNITAOUBBULa WBSC-LMS un1ing1deaiundn
ASUAIUAILTUADY ausasdunisanaeulmduludieanuiseuses waziiuseansain dinine
UsNsuasnAluladasaund YauNaus “NTeuiuni1s NISEs1LUUNAEaU” TussuuNISSeunIs

aouoaulal WBSC-LMS dasialuil

W
NS RERU
Turdstoaau

v

A1583714 Quiz

Viiagasiaday

¥

T edeUIn

ARYIPABUAYIY Quiz

v 4' o 1 v
138319 Category tWadnnuInvsvasdasau
WBANALAINUNITUSUISINNSUeda U (Question) Nazas1ebilumadedaaau (Question

Bank) vilidesensaumdeaeulundideasululdlilunuunaaey (Quiz) aeuaisivunnisaing
Ay (Category) vesdoaauLian1suITMIsIANIsNazAINTUlAENTAI1e Category BaHITNS
famalull

1. anmthaginednguituiles

2. AANLEBNANEY More...

1
1590N15VOUA
U
T " & Edit setting
Dashboard My courses N1TIANTTYUBYA i s
2} Course complation
_, Unenrol me from excel(0]
T Filters
& Gradebook setup
) B ; ) [ Backup
+ @ donnadlumateus & s
\T) Restore
1. ihszvuwseuiuluren 12,50 wodumsEvuuuvaoulad (@) Impart
2. flonssuntsieussuanatu nsdidne was VDO €1 Copy course
- S T SN W e i A Reset
3. ianssunseidsessdasdniiums biasaiuluusa
2 i Accessibility toolkit
B Recycle bin
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3. 1@9n Tab “Course administration” #1%3U® “Question bank” Lﬁamm‘g Categories

Course administration

Question bank

Llsars
Duestions l
LalEOres -
|mpaort
Export

4. s Add category

Parent category: l@®n category ®anlaz@3ng category o8

Name: A3%® category NABINITAI

¥ Add category

Parent category
Name

Category info

ID number

(T
wL/

Default for excel001 (32)

.
-

dagaulaluniAniaine

1| A~ |B| I

EE E E % %0 & we

5. zU57ny) Category gouiiasnaly

Y v a 7
6. 01M83IN15aU Category ﬂamﬁaﬂg‘d

v v a = {E\f\
7. fdieanisuily Category Adndonsy

» Default fo
The defau
&

Question categories for 'Course: ﬂ1§5ﬂﬂ’1‘i%ﬂ¥ﬁ‘

01 (32)

6 7
pry for que h?; ntext 'excel001".
A\

o tveasulanunmamsanen (0) [ &

v

Wemnuansulsmianyvestedauiisusesuds Jnnliunisaiteseulundeonau o

nsasetedeuaInIv avategULUY Aeralull
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fuinguszasavessgivily

o a o = = aaa Y v YN &
N153ALAZUSELIUNANITINNITLTLUNTEADY GZJ\‘ﬁJfJﬁﬂ'ﬁITJﬂ'ﬁﬁi']\WJ@ﬁ@‘Uﬂﬂﬁ]'f]lﬂu

A5a31999d0ULUU Multiple Choice
UodauLUU Multiple Choice Aatagpunuuiidon (Teaaulsie) aunsamuualineuls 1

U = =) U = Y aaa ¥ [ ! ndy
fiden visevangaudents dsn1sasenmeluil

1.

2.

3.

AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd

PnuhsgInaanguiiuiles > adnidenA1ds More...

Dashboard

N15IAN1VDYA

My courses nsdRnTiaya

+ @ domnaslunisitoui &£

1 vihszuundeunliinn 12,50 wdunmsBeuuuvanulad
2. fianssunisiuuiazuanaiu nsdifngn uaz VDO

- - » . - [ T -
3. flanssunisefivsessdawiiunisiiadeduluusazduami

Edit settings

@ &

Course completion

A4 Unenral me from excel001

T Filters

& Gradebook setup
[ Backup

& Restore

@ Impart

‘ﬁl Copy course

A Reset

I Accessibility toolkit

@ Recyele bin

o

LW@en Tab “Course administration” M%7 “Question bank” Lﬁammﬁ Question

Course administration Usars e
2
Question bank Questions e,

Categories
Import
Export

\d0n Category NIdoINISINUD@BUANNHIUD Select a category:

Questions

Categories

Question bank

Import Export

Select a category:

TRADUUATEAIANTTANET 5

Y &

No taq filters appli

Filter by tags...

Show guestion

Search options -
LI Also show quest]

I Also show old g

Create a new question

Course: excel001
Top for A13IAMTHONA
Default for axcal00]1 (32)
dpdatRl e umARTSANY
test (18]
Test(01 (4)
Category: Miscellaneous
Top for Miscellaneous
Default for Miscallanecus
Systemn
Top for System
Default for System
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4. @anyy Create a new question...

Questions Categories Import Export

Question bank

Select a category: feaaudatemanisdne %

No tag filters applied

Filter by tags... v

Show question text in the question list

Search options
[ Also show questions fr 4 kgories

[ Also show old question

Create a new question ...

5. @enguluuvestedau Multiple choice adnUy Add

Choose a questio to add X

QUESTIONS Altows the selection of a single or multiple

responses from a pre-oeling

i Mulsiple choice

] um True/False

Cancel

6. lddedoasulutes Question name 3edoiiaviJudsfininuanisisosdrsuvesdoasuly
Question Bank ffatumngesnislidoasuly Question Bank 13esd1dute avdiosds Question
name TiFoemuafiudtavn3onisnes 1y Q 001, Q 002, Q 003 tudu Ine Question
name g lduanaliindnwuiiu

7. Tdeanuludes Question text ansnsatiiugunim Clip 1dea Link Yoya laaniaasiiesie q lu

A A
LLEVULAIBDIND
¥ General
6

Current category Default for excel001 (32) (U gory

Save in category ‘ fomsuiawmamsinet/ ¢

Question name 0] ‘ Q001 ‘
. T - ;

Question text L 1 A~ | B! 1T = = = 7 &

© (& W & W™ & WP y—‘
TunsAunn Swudafinnatn #NAME? arsudluatigls
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8.  MUUAANALLUUTBITaERUlWIIUe Default mark

(M

Default mark 4 1

9. fAmuasukuuveNsiendmaulures One or multiple answers?
One answer only: {NAABUTIYNABANEAINDULIYY

Multiple answers allowed: lanfmaufignaedlauinndl 1 Ameu

10. M shuffle the choices: fnuslfaduidenmneuvazittodoy

11. AMmuagUluuresnsiansiidavesdiuben

One or multiple answers? One answer only 3

Shuffle the choices? (%)

Number the choices? 1,23, .. $ o 1

12. Tdmmaulunsaz@idaniuyas Choice warmuuaAAzkuulugae Grade

nshdendneunignaeslaiieadnauiien
- Mvuadeiignaedlvilidaziuuriniu 100%
- MvuadeiligneedvilAnzuuumiiu None
nsahdendmeunignaeslivialediney
° Y A ¥ D2 Y 4 o o Y i
- mvuatengnasdliiiidazuuumiiu 100% viserivuadadiuanauaiue %

° Y a1 v v 1 | @
- ﬂ'TViu@]‘sUE]'VlelIQﬂG]@QIV?.J@'W’]%LLUULV]']WU None

~ Answers
Choice 1 1 A B I = ElE =2 % S O M@E| ¢ w™ @
> - *
VUIWVUINAIUNI VB ILTAA 4
Grade None +
Feedback T W as | B |1 = EEE | % S O @Y ™A e
4
Choice 2 1 A~ B | I = EEE G | 95 @ | Gal @ LN | EE HP
as1adauailaiduitfiuigndaviald 3
Grade 100% -
Feedback 1 A~ |B| I =EEEE %S N © E ¢ A P
g
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a Save changes ‘
13. Aanyu

14. FegouiliinazUsngluadsteaay uavduiulaaeuazandn Category

35

Question bank

Select a category: ‘ doasuiansnianisdnu (1)

No tag filters applied

Filter by tags... v

Show question text in the question list

Create a new question ...

14

T* Question
O Question name / 10 number

ictions

N—

Created by

First name / Surname / Date

Last modified by

First name / Surname / Date

. e 2
Oi= lunisduim dmudofinnain #NAME? ... Edit ~

ANTIIN3 Munel
8 April 2021, 1:49 PM

AnsIninT3g Vivudl
22 December 2022, 4:14 PM

Tunsdtuam Smudefinnain #NAME? aasudluatgidls

15. fpsnsunly adn Edit > Edit question

T* Question . . Crq
Create a new guestion ... O question neme /10 n R IE Fird
T* Question 15 isigng Oz lunisAuin g % Duplicate ] :n;
O Question name / 1D number Tunsdnng ¥ Manage tags
= v T ! 15 @ Preview
O i lumimmm MWULRHANAIR #FNAMEY ... Edit = o -
E With select] T Delete
o T TEe 7% ’ ‘) lete ove 1o 5o -
Tun1sAun Swudeiinnain #BNAME? asun lvadals Delete  Move to > & Export as Moodle XL

16. FRINTISHAAIAIDE1INTSHARINATDADUNAS19L) AAN Edit > Preview

Tun1sfnuin swudaiinnain 8NAME? Arsun lwadtals

T* Question

Delete

Move to >>

Create a new question O Question name /1D nu {é} Edit question
T* Question 16 Actions O:z lunsdwamdmw @ Duplicate
O Question name / 1D number Tunsdnu W Manage tags
o 1 3 S . 16 ;i
Oz lunisdwim dmudafinnain #NAME? ... Edit ~ @ Preview
With seled

h

& Export as Moodle XML

w

Delete

17. f0g19NnL Preview k&3 AFNYN Close preview Uanthinegawasnduluntadsioasy

Question 1

Nat yet
answered

Marked out of

TunisArurm dawudetinnans NAME? aasudluadaals

1.00 Select one:

O 1. aynseuimwnidudasadililuansiriidouasswisli

O 2. aynssuieilwiuitiuigndomielu

O 3. wuwruInn1uniNYaLYas

O 4. ayn@sulsuanvestoyaiilddiuindigniemaundng 17
Start again Save Fill in correct responses  Submit and finish ~ Close preview

Sol
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15 Import Yadaunuyu Multiple Choice #28 Text File

UYoaoULUY Multiple Choice @1115011 Text File 11115 Import Tuszuuniauiumane 9

Folaannusiailunisusisdnnisteasu Tnsuwuseandy 2 Tunaundn tawn JunaunIsinTay

Text File hag TunouUn1s Import File

IS nsas1slunmaziunay sanaluil

JUNDUN 1: VUABUNISHAIUU Text File

1.

File Format Tuguuuuves Text File §mSun1sasieteaauuuy Multiple Choice 11150
denldlavateguuwuu Tundasinnisidenldsuwuy “GIFT Format” iednanunsafivuans
3% Question Name lvisgamuadiuteld Inevinisaistedeumey uueana .txt Ingld Text

Document/Notepad ¥1Mn13a3193Ukuuvedadaunyl Format fasialuil

ar = : . A
WALATBINUIY “7 11U 1 1Ag ]

ar =
WaAdLATDINUNY

@ ¥ = ; '
=Qo1: HMmsmuim smudafianaa #NAME? adsud luagals

“{* iu 1 g )
{ ~avwauan wavourad

- s W A ¢=iq sk = e o
~Asndeud B ayadi 19 lugashidoyasgriely
] = '
w o N g, y y ' a 2 Lo g
NOULATRINAY ~aaoulszmnvesieyanlainouigndesmdnadinmanivie

= &
Wi “=" iu 1 11z g o :
=asndeuFelsiFunfiuigndeniely }

v a a « y . v vy = o w
?Jaﬂmu‘l/laqmaium’iawma = 2”7 @B Question Name ﬁqﬂ(ﬂ@ﬂﬂqiiﬂmaﬁ@llLﬁENG]'WlIa']WU

Jolundataaau 1999%8 Question Name 158anud1Aui a3 ofenes wu Q01, Q02, Q03 1Hu

U

AU

2.

‘ﬂl « ” 1 L4 o ‘ﬂl 1 4
wsemny “~ ldnihAnauiiligneies
Wi “=" lanihAmmeuiignsies

nstuiinlndrmualsitimun Endcoding Wu UTF-8 iielsideninusessunisidauniwnlng

JuAUN 2: UNDUNIS Import File

1.

Pnmihglveinguiluiles > adnidenmds More...

N13AANIUDYA

= i & Edit setting
Dashboard My courses misiRnTstoya = |

& Course completion

24 Unenrol me from excel(001

T Filters

+ @-ia-;:n.n duntsidou; &

1. ihszvunsauiulunm 12,50 w fumsiGsunuuaaulmd
2. fimnssuntatisuiasuanaiu nsdifne uas VDO

3. fisnssunseivssesdosdiiunmsivaiaaulu
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2. 1den Tab “Course administration” M¥17® “Question bank” Lﬁamm‘g Import

Course administration Users
Question bank Questions
Cateqories

1Y

3. te File format tdenjuiuuratingiairalidmsurinng Import e Nilifie GIFT format
4. ¥Ue General ldon Category 79N 1SIANTOEDU
5. Stop on error ivuaANdu “Yes” tiolilunsdlfilvad Import Elgymazuananiingng error

Tinsiageunau azldilng Import assyuu

Questions Categories Import Export

Import questions from file®

* File format
O Aiken format @
O Blackboard (@
O Embedded answers (Cloze) @)

O Examview &

GIFT format @

O Missing word format (@)
O Moodle XML format ()
O WebCT format @

* General

-

Import category @ | Yeasuvaiuaamsdne (1)) %

Get category from filetd Get context from file

Match grades (Z) | Errorif grade not listed  +

g 5

Stop on error ) | Yes

6. ¥ Import questions from file LdenlWdnidesnisiaeadnidenyu Choose a file...

~ Import questions from fj

import (U | Choose afile..: 6

~

You can drag and drop files here to add them.

s v a L o U s o w a a a a v a
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a .
7. manyu Choose File
File picker x
0 Server files =
*n Recent files
Attachment
&a Upload a file
No file chosen
& URL downloader
Save as
h Private files ‘ ‘
29 Wikimedia
#h Content bank Aty
‘ anssainig viuudl ‘
Choose licence (?)
‘ All rights reserved v
= sy a
8. \denlwdsaans > adnUu Open
Organize = Mew folder (il | o
2 Mame Date mcdifi\éd
7 Quick acce
* Downl # V_TOday m 8
£ daaougift format.oct 03/02/2566 14:33
& This PC
i ) Select a file
1 3D Objec to preview.
[ Desktop
£ Documer
* Downloai
b Music v < 8
File name: | dosougift Format.bet ~| | All Files C.ﬂ ~
Open Cancel
a 1 . .
9. manyn Upload this file
File picker X
T Server files — ™
n Recent files
Attachment
& Upload a file
ﬁ'aaaugiﬁ format.txt
& URL downloader
Save as
h Private files ‘ ‘
9 Wikimedia Author
& Content bank ‘ Anssdinig Muudl
Choose licence (7) 9
‘ All rights reserved v
AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd diininguimauazimalulagansauna unIveduaIunan



10. WePelwdusnglunsey Import Adnta Import

39

P
{11

WL

Import

¥ Import questions from file

Choose a file...

‘ﬁaﬁa‘ugiﬂ format.txt

10

o

11. YeapuazUsngauiuindeiiundy adndu Continue

Questions Categories Import

Parsing questions from import file.

Importing 1 questions from file

1. TunsAuam dwudstianain #NAME? aasunluadi

Export

12. U0adULLANIIUNTINASITEDU

Questions Categories Import Export
Question bank
Select a category.“ feaeulatnmianisfinw (1)
No tag filters applied
‘ Filter by tags... \J ‘
Show question text in the question list
Search options »
[ Also show questions from subcategories
[ Also show old questions
Create a new question ...
T“ Question Actions Created by Last modified by
O Question name / |D number First name / Surname / Date First name / Surname / Date
s ©oL AWSIENTg viuudl GV UER T
U= Qo1 Eelit 26 December 2022, 4:18 PM 26 Decermnber 2022, 4:18 PM
Tunnsdruan Smudafinnann #NAME? aasudluadsls
With selected:
Delete Move to >> s
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NSINNYRERULUY Matching

UoaoUWUU Matching Fledeapuuwuuiugmidenitmyvual d35nsasedaseluil

1. anmthaginednuituiles

2. @dn@eNANET More...

N15IAN5VOYA

Dashboard My courses n159ANTSU0YA

{2 Edit settings

£

2 Course complation

o

2% Unenrol me from excelQ0]
T Filters

& Gradebook setup

r " & & [ Backup
+ @ domnadumsdens £ ® Restore
L vinszuuwdauiuluan 12,50 w. WunsEeuwuvaaulat @ Import
2 ﬁ:lﬂﬁun'm'i'uufwuamﬁ]u nsiiAne wag VDO 8 Copy course
3. flanssumseivseesdasdnfiumsliaseiuluusia A Reset

e Accessibility toolkit

@ Recycle bin

3. 1@an Tab “Course administration” %98 “Question bank” Lﬁamm% Question

Course administration

Question bank

Lsers
J 3
Que 5ti-::.n5<-\
Import
Export

4. \@en Category NADINITINUDEDUIINTIUD Select a category:

Questions Lategories

Question bank

Import Export

Select a category:

HRADULUR A WA TANE =

Mo tag filters appl

Course: excel001
Top for NIITAM THEYA 4

Filter by tags...

Show guestion 4

Search options
Ll Also show guest

_| Also show old gt

Default for excel001 {32)
gEdsnlEmARTIANE
test (18)
Test(:01 (4)
Category: Miscellanecous
Top for Miscellaneouws
Default for Miscellaneous
System
Top for System
Default for System

Create a new question 7

AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd
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5. aanUu Create a new question...

Questions Categories Import Export

Question bank

Select a category: domoulatsnan1sdnen ¥

No tag filters applied

Filter by tags... v

Show question text in the question list

Search options

[0 Also show questions fi 5 egories

[J Also show old questio

Create a new question ..

6. \aenjuuuvesaday Matching AanUu Add

Choose a question type to add X

6

QUESTIONS The answer to each of a number of sub-question

must be selected from a list of possibilities.

®

Matching

e

/1  Short answer

Drag and drop

@

markers -

Cancel

7. ld¥evsasulures Question name F9todazidudaniinuanisisusdisuvasvaaauly
Question Bank satiumIn@aIn1siteaaulu Question Bank t389816U78 98Aaa9 Question
name TABIMNARNUMIIAISORONYS WL Q 001, Q 002 tWudu 1ny Question name gl

Y = =1
LARS LA AN

8. Tdmauluses Question text

¥ General

Category daday wAne (1)

Question name (D) Q 002 ,

T

Question text L

1 A B I = 8 S5 0% %

© @ @ & W™ A HP 8

s al

Jugdadas nuaramaneligneias /

v a

s v a L o U s o a a a v a
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9.  MuAAALLULTRIlRERUlUTTD Default mark

Default mark 0 3

10. M shuffle fuusliagusidondineuunsyndoasu

11. ABNANNY LATAINBUNABINITIUA

Y

Question 1 1 A~ | B I : = R
© G [ ¢
Remove Diplicate AnNau
Answer nsavdayaiiisionisdituunnit 1 senslivdaio
Question 2 1 A~ B G |
© & = ¢
Pivote Table .
AU
Answer A15UITBLATIUIULINUIMIINITATIAITN '[un'r‘ﬁfﬁ |

a Save changes ‘
12. manyu

13. YaapuiiinazUsnglunditedsy wasdnuiudeaauIziandil Category

Select a category: deaaudatananisAns (2%
No tag filters applied I 12

Filter by tags... v

Show question text in the question list

Search options
[ Also show questions from subcategories

[ Also show old questions

12
Create a new question ...
T“ Question Actions Created by
D Question name / 1D number First name / Surname / Date
Dz 0002 Edit ~  @nIsainTa vivual

9 January 2023, 2:41 PM

] e W o [ 2
Juatarida Auaumineligndiag

- W . EWSININTG Vel
D:= Qo1 Edit 26 December 2022, 4:18 PM
TunrsAruna omudaiinnann #NAME? Arsunluatndls

v a

s v a L o U s o a a a v a
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14. fpsnsunly adn Edit > Edit question

43

Create a new question ...

14
T Question ctions
D Question name / 1D number
O:= Qo002 Edit ~
Juateards Auanumanulignsios
= Q01 Edit =

TunisAnuan dwudaidawatn ENAME? Aasun e

Create a new question ...

T* Question

O Question namea # 1N rumber

O:z Q002

Jugannda fiue

TunsAnunn i1

]
iz Q01 L
Q
With selected: i

Edit question

Duplicate
Manage tags
Preview

Delete

14

Actig

e

15. ARINSHANIAIBENNTWaARINaT @R UNas19l) AN Edit > Preview

Create a new guestion ...

=

T* Question 15 Actions
0 Question name / ID number
Oz Qo002 Edit =
Juddodnds fumnumneliigndas
C:= Q01 Edit ~

TunsAnunn drwudaiinnain #NAME? Arsudluae

T* Question
O Question name

Ui Q002

(= 8 = & o
AURTBATEN AIUE

With selected:

Delete Moy

Create a new question ...

=]

Edit question
Duplicate
Manage tags
Preview

Delete

v of)e s @

Export as Moodle XML

16. Hendiag19anmin Preview ud3 AdnUY Close preview LiteUanidisgauagnaulugdmi

ARIUDADU

Question 1

Not yet

W e W ow ar £y
FUATDANEA ﬂ‘Uﬂ’J']MHM'IUIHK‘]ﬂWEN

answered

Pivote Table
Marked out of

msideyaduamnnuminnisainemisne lumsiesied asua Ao ¢

.

Choose...

4

Choose...

3.00 Remove Diplicate
Conditional Formatting
Start again Save Fill in correct responses

Submit and finish

Close preview

16

1

® NSINNTREBUKRUY True/False

UaapURUY True/False AadoaauiuuuunisarumauLazidonnauntennuviayselen

Wianliu gn vise An Tisn1saseiwalull

1. nmthsgdnednguiiuiles > adnidenAds More...

N159ANNSTOYA

Dashboard My courses

+ @ damnadlumsiioud &

n1siRnstaya

1. vihszuundeuiuluim 12.50 u. WunsGeunuveeulm]
2. fianssunsieuiazuanadu nsdidne uas vDO

3. franssumiseiusieesdasiniunisifadeiuluusazauam

& Edit settings

::‘:* Course completion

2% Unenrol me f

T

% Gradebook setup

[ Backup

1) Restore

AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd
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2. @an Tab “Course administration” %98 “Question bank” Lﬁamm‘g Question

Course administration Users
Question bank Questions e
Categories
Import
Export

]

g —

3. 1@9n Category NADINISINNUDERUINKITD Select a category:

Questions Categories Import Export

Question bank

Select a categony:

FEADUUR TN IFNTTANE

-
-

Mo tag filters appl

Show question 4

Search options
L1 Also show quest

| Also show old gy

Create a new que

Course: excel001
Top for ATSIANTTIBLA

i Default for excel001 {32)
Filter by tags... geaaulaumanTsAne

test (18)
Teast001 (4]
Category: Miscellaneous
Top far Miscellaneous
Default for Miscaellaneous
Systemn
Top far System
Dafault for System

3

a. ﬂaﬂﬂu Create a new question...

Questions

Select a category:

Categories Import Export

Question bank

dagaulansnIAn1sanen

-
-

Mo tag filters applied

Filter by tags...

v

Show question

Search options

text in the question list

[ Also show questions 4

[ Also show old questi

Create a new question ...

ategories

AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd
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5. Wenguluurestadau True/False AanUu Add

Choose a question type to add X
QUESTIONS A simple form of multiple choice question with
5 just the two choices True’ and 'False’.
e -

Multiple chai

@ s True/fFalse

@) 2.‘3 Calculated

Cancel

6. lddedoasuludes Question name dsdoiiaviJudsfininunanisisosdrsuvesdoasuly
Question Bank sfatumndiaanisidoaauly Question Bank 138381 ute avdosis Question
name T3 uaduiiawniemeonys wu Q 001, Q 002 1usu

7. Tdaanuluaes Question text

8.  MuunAAzLuLYstadauluiide Default mark

~ General 6
Category ‘ sﬂ'aaauﬂm;/mﬁn (2 =+
™ 4
Question name (D Q003

Question text '@

1(|A> (B | I | =|E

7

© M @ ¢ W WP

Wiensendavluden Cell udausingusamuy P uansin anuniisvos
G4 Cell lsiwadi uadldnsu

Default mark (D 1

9. @enAmeaunignaes 31 True vi3e False

10. 1d Feedback Tunsdilidennau True wag False (81

Correct answer \Eﬁ 9

Feedback for the S [N R [—
1 A~ B | I E EIE = %%
response ‘True'.
© @& @ & =™ F@ wr
Aasinus1u1NnN11 ATUNI14T4Ta4 Cell azfasun)y V89104

cell Tty vinliuaninavasnnanldnaiun 10

Feedback for the

1| |A~ | B |1 ||E| = E E| %%
response 'False'.

© @ B ¢ W™ P P

indnwmauAtnuligneag 10

s v a L o U s o w a a a a v a
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a Save changes ‘
11. mandu

12. degouilviinazUsngluadstesey uavduiutaaeuazandn Category

Select a category: toaaulatgnianisdnw (3) &
No tag filters applied 12
Filter by tags... v

Show question text in the question list

Search options «
[ Also show questions from subcategories

[J Also show old questions

Create a new question ...

T* Question Actions Created by
O Question name / 1D number First name / Surname / Date
L. anssiinng viuudd
. = Q002 Edit 9 January 2023, 2:41 PM
JuATanAAs vl 12 QUGN
i . ANSIOINNT VUL
Uiz Qo1 Edit 26 December 2022, 4:18 PM
TunrsAunn dngfoinnain #NAME? arsudluatisls
O.. Q003 Edit = ANIIRNT3 TUual

9 January 2023, 3:25 PM
dionsandaatlutad Cell udrUsinawmsosnany “#” uanidl aAnuniiae

13. fpsnsunly adn Edit > Edit question

Create a new question ... (J:z: Qo002 Edit %
T“ Question Actions JugPeAds nuarumaneliiondas 13
O Question name / 10D number = QU‘] Edit questim
Oz Q002 Edit - s
i Q . lunisdwat ¢ buplicate i
JUATEAE NUATILALN — il
= Q01 Edit ~ .- QOO0 % Manage tags ]_
= e diansandnl ; 3
TunsAnunm dnutodnNE T BENANG? ATSUA With seledt @ Preview 3
With select -
O.. Q003 Edit ~ U Delete
3 = : = i Delete IF
dansansnavlutos Cell LAIUTINGLATDINN & Export as Moodle XML |

14, ARINSHANIAIBENNTWARINaT R UNas19lY AN Edit > Preview

Create a new question ... Uiz Q002 Edit ~
T* Question M Jugtedds nuaruvuielinndas
| Question name / 1D number Ds; Qo1 {é} Edit question
i Qo002 Edit ~ -
ol O ¢ ) Tumsdme &y Duplicate 14
TUATBATAT NUATILWNY O Q00 W%
.. | Manage tags
O:= Qo1 Edit ~ A getag 1]
5 - i LIaNT0NN Y i
Tunmsdun dwutadn With select
ith sel a
Bl s Q003 Edit = U Delete
= = > = = Delete
diensondawluzos Cell waUsINgLATa UL & Export as Moodle XML

A v a

AlensldnussuunmaiFsunisasussular WBSC dwiuenaise dindneuinisuagivaluladansaumna umineduaiundn



47

15. \Hendieg19anmin Preview wdd adnUu Close preview LiteUantindiagauagnauludmii

2 v
ARNUDEDU
Question 1 diansenavludas Cell udgrUsngAsaamane “4#” uaniin ATUNIIUes
Not yet %24 Cell lsinafiazuaninavasdnavlinsu
answered
Marked out of Select one:
1.00 .
O True 15
O False
Start again Save Fill in correct responses Submit and finish Close preview

NSUUBEBULUY Short answer
foaauluy Short answer Aanisiivuaguiuunisneumatududineudu 4 lnedaou

mvuasUwutlunsneumauiasfvuaasiuuyesgUluuiig q 13 F8nsasieiwielull

1. nnihnginednguiluiles > adnidenmds More...

at L4
N15AANITVBUA ]
u
S i Edit settings
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R + 3 =& o0 lumsdnn Smudefianann .. @ _a random guestion l 13
& B = . ® _anew section heading
- 4 i {8 Microsoft PowerPoint aunsainaus...
New heading o O Shuffle
\/ 14
Page 2 14 dd ~
- + 2 g2 Sustedids fuauvnslvnndas a U 300
=1
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15. AanidenYerasuuUNAaU (Quiz) IMNIUYATUUUYDITILIYT LHDAAIE19NITUANIHA

Dashboard My courses nsdanistaya uuuvAgauiaunniey uuuAgaydIn1siuy (Posttest) Edit quiz

Editing quiz: wuUNAABUNRAINISISEU (Posttest)a | 15

Questions: 5 | Quiz closed (opens 15/01/23, 10:00) Maximum grade | 20,00 Save

Repaginate Select multiple items Total of marks: 20.00

YpdaudnlY £ O shuffle ®

16. Aaniuilag > L@BNAES Preview

LUUNAABUNAINSL38U (Posttest)
oy ey im S I e
| Closes: | sunday, 15 January 2023, 10:10 AM | iz R

*** User overnides

‘ Mark as done | B :
) w2 Edit quiz

@ Previe

16
L4 o
17. meﬁmymuaﬂmimLL‘UUVIVW?IE]‘U
a W
N133NNIVANA
Dashboard My courses Msinn1sTeya WUUMAADUNBUNTSEEL UUUNARBUMAINTSL3UU (Posttest) Preview

You can preview this quiz, but if this were a real attempt, you Siiiznaigaton
would be blocked because: . o o
This quiz is not currently available ‘Ugmuﬂ
Question 3 Tumsdnuam dmudafinwann #NAME? Arsudluatisls

i) Jadauusily

- = o v o . £ ar - & e
O a. FIi'llilﬁa‘U‘L]iEI.ITVIﬂﬂﬂﬂﬂ}dﬁmﬁFI"IU']EIJT‘IQ?'IWﬂiﬁl"li]ﬁﬁﬂﬂmﬂﬁ?ﬂﬂiﬂiﬂ El 5
Marked out of 1ad . .

L.00 = 4 S om o e v w Wy
O b. sﬂi:maa'uwjaﬁqnwjm?wqunﬂawiﬂu -
¥ Elag question - . Finish attempt ...
= O ¢ WIWTUINAIUNINVBLTAR
<S¢ Edit

asiion O d. anedeuiwnidnduvadililugnsiiideyaeguiali Sl A

Previous page Next page

o msvesauldluvesiuunaiou JUwuu a random from Question

1. manyy Turn editing on

N159AN15UDYA

Dashboard My courses ﬂﬂﬁﬁmﬂﬂﬁﬁaga

@ gannadlunisiseus
L E wr = - €
1. iirssuundaunulunai 12.50 u. 1unsSeunvuaoulal

A v a
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2. AANEBNTMTRTRILUUNAEDU (Quiz) Nas1eld

Mark as done

S s 2 s T
ﬂ"li‘r’lﬂaﬂmﬂuLLUUU'iuU 4 puasn ﬂﬂﬂﬂjmﬂuﬂgﬂﬂaﬂﬂ?ﬂﬂLWUﬂ‘UaLﬂU]

+ e wuunAaaunanIsseu (Posttest) & Edit ~ @

3. adnguiles > adnidenAds Edit quiz

LUUNAADUNAINISISBU (Posttest)

& Edit settings
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 loses: | Sunday, 15 January 2023, 10:10 A " Group overrides
*** |Jser overrides
m L] L]
@ Preview

4. @anEan Add > a random question
.y . . ot = P
Editing quiz: LLUUNA@DUKAINILI8U (Posttest)®
Questions: 0 | Quiz closed (opens 15/01/23, 10:00) Maximum grade| 20.00 Save
Repaginate  Select multiple items Total of marks: 0.00

Vi ] Shuffle @)

® anew question

® _from question bank

® arandom question

5. \den category Nad1eUnaauld

6. MMuAIUILYEaADUNABIN1SdY (Random) 3 NARItaaBY (Question bank)

-
7. Aanyu

Add a random question at the end

Existing category New category

Category Default for excel001 (28)

[ Include questions from subcategories too

Tags (@  Anytags

Search A/
Number of random 10 + =
guestions 6
Questions matching this filter: 28

<23456>

iz Tusunsu Microsoft PowerPoint tianzd wsulunisdnvinanasuszanin

v a

s v a L o U s o a a a v a
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YaapuIzUsnglugeiuunadaay

9.  AzuUUAUTITINAAzUIINg YR Total of marks

10. Hasuanunsamnuaazkuuinvesnsaeuluusazasildfives Maximum grade wiindniy

Save WatuINALMUULALARIAUA TN

11. 1don M shuffle ileswunlviadudeaauls

Editing quiz: HUUNAABUNAINTTITBU (Posttest)®

Questions: 10 | Quiz closed (opens 15/01/23, 10:00)

Maximum grade| 10.00 Save

Repaginate  Select multiple items

Vi 8 [ Shuffle @)
Page 1 Add ~
& 1 & & Random (Default for excel001) (see questions) 1 Q 0 1.00£

L 4)

=1
Page 2 Add -
G 2 & & Random (Default for excel001) (see questions) Q U 1.00¢

L4}

m
Page 3 Add -

10
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Total of marks: 10.00

12. iedpanspmegevednuunaaeuiilaasield adndenderewuunaaey (Quiz) 91Ny

ANUUUYDITIEIN

AsdAn1sioya uuunndaUfaun1sEuY

wuuvinaagmaanisisuy (Posttest)

Edit quiz

Dashboard My courses

Editing quiz: LWUUNAABUYAINTSIS8U (Posttest)o| 12
Questions: 5| Quiz closed (opens 15/01/23, 10:00)

Repaginate  Select multiple items

YadaudnlY £
Page 1

+ I

El & Q.005 2395u1w 38n5uiilda1u email vasInondvinwadam

Quiz

Maximum grade| 20,00 Save

Total of marks: 20.00

[ Shuffle &
Add ~

@ O 10008

m

13. Aanfluiled > L@anAE Preview

LUUNAEDUNAINISIIBU (Posttest)

 Closes: | Sunday, 15 Jamsary 2073, 10:10 AM |

[ Mark as dane |

arRdauusuTie 4 {?ﬁLﬁanﬂﬁﬁ'ﬂﬁﬂu'ﬂ,ﬁnnﬁ"mauﬁq NABINERLITOLALN
[ - i o 3
WaABVUTIVUR 15 18 ABLULAY 15 ABuu

valumsiuuunaaay 10w

5o <
w2r Edit settings
= Group overrides

== |ser overridas

o i f
w=r Edit quiz

i Results
@ Grades
@ Responses

@ Statistics

13
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14. LLﬁﬂﬂﬂﬂ’w}INQJ@Qﬂ’ﬁﬁ’]LL‘U‘U‘V]@ﬁ@‘U

Question 3
Not yet
answered

Marked out of
1.00

¥ Elag question

@ Edit

guestion

Previous page

You can preview this quiz, but if this were a real attempt,
you would be blocked because:

This quiz is not currently available

#lo HR wa1U3d ABC Aaamsdnousuminaulusuuunaunaiunis
ausuuuvasulad uar nsvinau viEvasiden ldueunwirduludala

Select one:

-
{

J

—

J

a
b.

C.

Yammer
OneDrive
PLANNER
TEAMS
STREAMS

Quiz navigation
(]

Finish attempt ...

Start a new preview

o
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UNY 5 N15ATIVNUNUBUNRUY LAZAITATIAUUUNAGDU

nsnsRunNeurueliinAnyl (Assignment)
WetnAnw1dauilaSuteununelseuieuna HaaualuiIsonsauuounuiey

(Assignment) 16 1ngA15759991n11158UU %58 Download wiensiaaudunuy Offline ¢ @il
Wwnsasselull

1. AanITe Assignment NILBUNLNBIUTNANEN

% @ dousheuni 12

‘ Mark as done

1.  Tusunsululasvawddnea ( Microsoft Excel ) iulusunsuissinnla

2. oaeanislagunmilulwasu szAsaiensdndsi Ribbon 1a

LABNATIANILADULSYUNADINT
Participants: WangI UIUENANYIlUADUTEL/51873%)
Submitted: WEAIINUIULNANYINEIIUNLD UMY

Needs grading: wansdnuwintndnwndslllasunisnsialinzuuuiueumniieg

A T

AanYu View all submissions tiegs1e¥atdn@nwiievualunewlsew/s1e391 v3e aandy

Grade: WiansaliAzwuu

Separate groups | All participants %

Grading sum

Hidden from students 3 Mo

Participants &
il

Submitted P 5]

Meeds grading 5 2

View all submissions

7. Weadnyy View all submissions S¥UUKAAIMENM1S19518T0TINANY

- @NIULAT9ZUERY Status: Submitted for grading

- g9laidaauazwang Status: No submission
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8. MeIMInTIAbATIUL Assignment AANUY Grade
First Last
User name / modified
Select picture Sumame Email address Status Grade Edit (submission)  File submissions
o © © © 7 © © © ©O ©
O 0 30T wi_ko@dusit.ac.th ubmitted 8 [aturday, 1 L@ Favipdf
: ALY for grading ay 2021,
) 4:30 PM
d f‘ Uﬂam suk ru@dusit.ac.th Submitted Edit ~ Saturday, 1 @ ﬁnam.pﬂ
i InEdu for grading m May 2021,
) 4:18 PM
] W u6412345678904 No _n Edit = -
A1839 submission -
angs )
9. agUsnguinldnuninfnwds daeuanunsansianumeinsesdlofiuauiasesiionuuy
10. pdndenlyla e Download tWantnAnwidsla
11. Tvimgnuulutes Grade out of ...
12. Tadewausiuzinaipuluyas Feedback comments
13, WasuyuLDINTHAAINELA
14. Aanyy Save changes
15. Adn View all submission enauluniimsiesiedetdn@nen

Course: M3AANTSTaYA

it 18

View all submissions

- W o )
& ANAAT INENU
suk ru@dusit.ac.th

| Change user \al 2

&)

O B

¥ |k ([ |\ |O|O ¥

6T
]

) PT
1 Tsunsulalewansidniea ( Microsoft Excel

TUsunsuus samanseruam

celsx

a4

Windows / 9

2 i anslagunmiluliid i asdondanddsil Ricben Tn X

3 Tldam Microsoft Excel fidufinuinasiunianala /

Microsoft Excel ¥iamumalés suufuaniste

14

Notify student & 3 Save changes Reset

Not graded

Student can gt this submission

Comments (0)

1 May 2021, 4:18 PM

Grade

Grade out of

Current grade in gradebook

13

Not graded

Feedback comments x

1 A~ |B| I

12
= E == % S
© @ W ¢ WP P
e Wndndwalfasuion
im] m

16. %1N929n15 Download Wduvesin@nwuinsianuy Offline L@0NMRUSIUNADINTS

AxensldnusTuUMISsunsaeusaulat WBSC dwiue1ansd

v a

dinan

gusnsuazAluladansaumna unnInendeaiundn




17. AanUu View all submissions Liteaseteiindnymananlunewseu/s1e3

Separate groups

All participants =

16

Grading sum

Hidden from students No

Participants 6

Submitted 5
17

Needs grading 2

View all submissions

18. fivide Grading action La®n Download all submissions

Grading action | Choose... :
Choose... 18
Separate group:
Firstname WA 2 £ C D E E G H | N OPOQERSIUVYWXYZ
SumameAEQDLEQHlJBLMHQEQBéIQ!ﬂEIZ
First Last
User name / modified
Select picture Surmame Email address Status Grade Edit (submission)  File submissions
0O @ © S © © © © O]
O 2] 3113 wi ko@dusit.ac.th Submitted Edit *  Saturday, 1 “@ 3nTipdf
) AU for grading May 2021,
4:30 PM
s o = =
19. Trldazgnduiinlily Folder Download vedATas
a A .
20. AANgNAT > Laan Show in folder
Grading action | Download all submissions #
Separate groups | All participants =
Fi"‘it”ameméﬁgﬂifﬁﬂliﬁl_-MHQEQBQI!EWXIZ
Sumamemaﬁ;ggfgulgﬁgnugggﬂéluywziz
First
User name /
Select picture Surname Status Grade Edit
0O € g © © ©
Always open files of this
O ) it.ac.th Submitted Edit ~
Show in folder -
for grading
Cancel
h |
B excel001-Anaie...zip = ¥ I Show all
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21. 1 Folder Download %Uﬁﬂgﬂv\lé‘ﬁ Download

22. AANYMANUNA Download > 1aen Extract Here 2zl Folder $nuvadinfne

« L & » ThisPC > Downloads 271 v | 0
. Today (1
7 Quick access y (1)
"' Pl ? gaceli}ﬂ'l-mnwmumm 1-61.zip
& This PC
;Iﬂ B — O *
Home Share WView a
b 3 qi]v
x- B % P +
A = [ A M
Pin to Quick Copy Paste . MNew Properties Select
ACCESS =l folder ) & =
Clipboard Organize New Open
— v 4 -‘- > Thi.. » Downl... v | D L Search Downloads
Yesterday (4)

"
s Quick access
.‘ Downloads " e 22
o
usma fidy_16_assignsubmission_file_

m This PC 3% aush_3_assignsubmission_file_
) 30 Objects dndion snasu_4_assignsubmission_fil
[ Desktop

ANSAIUVUNATUDALIY (Essay)

wuuneaeusnils (Essay) Iunuunaasuiifaeuszdesinnsnsiuaslviazuuusdionules
KusEUU WBSC tielisyuuasunansiuusind 4 lusiedu awnsavile 2 35 Ao

B 1: ATIUUNAABUTIBYARAHILITUY WBSC

89 2: asuuUNaaeuUlng Download 1aapuUNIMTIaWUU Offline

(%
[

1 I aa [ £Y
fﬂi'—J‘r\]LLUUW@a@UiWS‘U“ﬂﬂaNqu58UU WBSC u%um@u’gﬁﬂqiiclJﬂ']imi?"ﬂLLUUW@?{@U@G\US
(Essay) fiail

1. mandenivsuuunagausniiy (Essay)

LUUNAAD VDALY .

Mark as done

wuunadaUaniy

Edit + £

YDADULUVUITHY 27U 2 98
d9a2 10 AZLUY 574 20 AZLUU

LAWIILUUNAgDU 90 WA
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AaniangUies > Uy Results aneda Grades

LUUNAAaUDRLE

 Closed: | Wednesday, 18 January 2023, 10:45 AM_

Mark as done

uwUunNAdaUSALY
JadAvuULUUUTIENY 911U 2 T

@z 10 AZLUY 523 20 AZLUL

2 Edit settings
*** Group overrides
*** User overrides
5 Edit quiz

@, Preview

| Results

@ Responses

@ Statistics
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3. Aanden Requires grading Y8UNANBINABININTIAVOADULARLUD

First name /

O Surname
i
Soud
0| |
: Review
attempt

293 iniSuu

5 Review
attempt
A7 Audin
O 9 Review
© |attempt

Email address

u6412345678901@mail.dusit.ac.th

u6412345678902@mail.dusit.ac.th

wi_ko@dusit.ac.th

State

Finished

Finished

Finished

Started on

18 January
2023 10:18
AM

18 January
2023 10:29
AM

18 January
2023 10:30
AM

Completed

18 January
2023 10:22 AM

18 January
2023 10:29 AM

18 January
2023 10:30 AM

Time Q1 Q2

taken Grade/20.00 /10.00 /10.00

3 mins [Not yet Requires |Requires

51 secs |graded grading grading

g Not yet Reqﬁ 3
graded grading

Tl Not yet ReqL{lres Reqelres
graded grading grading

4. @Aan Make comment or override mark

Question 1
Complete

Marked out of
10.00

{" Flag question

‘ﬁl LS = =1
@ e Soud

Quiz uuUNAAIUARLIY
Question Q 005
Completedon Wednesday, 18 January 2023, 10:22 AM

2995U18 3815w lHu email vasuw e dvu e dauuy

asidnldau
LD4N19ATd

2). uAa1ns M www.outlook.

AllansldnusTUUWAIMT e Ay

1.) UnAnw 91 www.outlook.com/mail.dusit.ac.th

® office3652.jpg

.ac.th

Make comment or override mark
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° A A s Ao | o | v a
n319mneU MsoWalwduuuntndnwidsmneu Tadaiauowus (613 warliazuuu > adndy

Save
e dlawh Geud
.
Quiz WUUVIRABUARLY
Question Q 005
Question 1 3485U18 33151t 1H97u email vaauINENABLINEA LY
Complete
Marked out of aflensldruszuuwduninetde 5 -
10.00 ey
asulgau
¥ Flag question HAINT19IFS 4
1.) 1indAn®n A www.outlook.com/mail.dusit.ac.th
2). URATINST 71 WWW.0U /dusit.ac.th 2
i : P
: i 5
® office3652.jpg
Comment
1 A~ | B I = = = Yo | <5
. & o v = 5
msiuianswaziBua lidniaudiu
A
5 Mark
T out of 10.00

sruuasUantinnishinsuuy uazasusinguinuanideiauaiuzaingaounill > adnlu Close

this windows

& e Goun
<

Quiz wuuVAEDUBALLY
Question Q 005
Completed on Wednesday, 18 January 2023, 4:48 PM

Question 1 2495U7w I5nstnlEau email vsuAINeIavLIWaANYY
Complete
Mark 7.00 out of Allen1sldrussuuduTIneay -~
10.00 e
Nt g
¥ Fldg qLJESL‘IUI'I eﬁaqﬂjqﬂiq

1.) tndAn®n 7 www.outlook.com/mail.dusit.ac.th
2). yAans M www.outlook.com/dusit.ac.th

® office3652.jpg

Comment:
AIsULEawIswazBunldnaudu

Make comment or override mark
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7. denauindminnisliazuuy (Grades) Refresh wii1ae azUsingaziuunlinswuutindnwly

First name Time Q1 Q2
O /Surmame Email address State  Startedon Completed taken Grade/20.00 /10.00 /10.00
et
Svud 18 January |18 January 3mins |Not yet Requires
O @ : i u6412345678901@mail.dusit.ac.th | Finished| 2023 10:18 (2023 10:22 7.00 :
Review 51 secs |graded grading
AM AM
attempt
¥95 $niSeu 18 January |18 January
c - . - Not yet Reguires |Requires
O Review u6412345678902@mail.dusit.ac.th | Finished | 2023 10:29 |2023 10:29 39 secs : )
graded grading | grading
attempt AM AM
v . Py aa
- asakuunageulang Download Tp@UNIRSI9LUU Offline HTunauidnislunisnsia
o U U d’l
kUUNAdauanuy (Essay) Avy
a A v Y v W
1. ARNEBNINVBLUUNAADUDAUY (Essay)
al.mmﬂaaua”mﬂw Edit ~ L
e 1
Mark as done
wuUNAdBUSRLY

2. pandenguiles > 7y Results LdenA1ds Responses

wuun

Joax

LUUNAADUD ALY

 Closed: | Wednesday, 18 January 2023, 10:45 AM_

Mark as done

AUy

FDADULUUUTTUWY 21U 2 U8

10 Az 573 20 AZLLUL

¢ Edit settings

*** Group overrides

**+ ser overrides

£ Edit quiz

@ Preview

[ Results
@ Grades

@ Statistics

<

3. 798 Download table data as vaantdu Microsoft Excel (xlsx)

4. adnyUu Download

Download table dataas | Microsoft Excel (.xlsx) + | Download

First
name /

O Surname  Em 3 q Grade/20.00 Response 1

©@ @ © @ © @

o @ Wesih  u6412345678901@maildusit.acth  Finished  Not yet AilonsldauszuuaE
150uf graded uninende msidnldiu daamianse
Review 1.) updAnw 7
attempt www.outlook.com/mail.dusit.ac.th 2).

L GAER]
s v a L o U s o w a a a a v a
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5. lvdazwandly Folder Download

o «~ 4 ¥ > ThisPC > Downloads v O
S
: T = 10
3 Quick access G
= excelDD] -vuuweszudmiiy-responses.xlsy
‘ Downloads + B P
[ This PC
) 30 Objects
B Desktop
[ Documents
& Downloads
A2 - & Faud
A B g D E E G H
Email Complete Time Grade/20.
1 Surname First name address  State Started on d taken 00 Response 1
u6412345 18 18 sYUULUE
678901@ January  January uWIINEN&al
mail.dusit. 2023 2023 3mins51 Notyet  A1stzlHonu
2 |[Baud iaaih  ac.th Finished 10:18 AM 10:22 AM secs graded  faunnunsg
u6412345 18 18 SYULLUA
678902@ January  January UWINENAH
mail.dusit. 2023 2023 Notyet  mistznlHionu
3 [$n3au 13§ ac.th Finished 10:29 AM 10:29 AM 39secs graded  fHadn1dnsd

o o Y =2 v . =
N193INANTIYINIVIYA (Restrict Access) UaIUNANEI

72

TuN159ANISIIIUNTADULAALIIEATT UNNS18ABILNA8NDULTYU WOANUAZAINLUNITE

%

U J@oUNAIMMUANTISIUIAY Activity 130 Resource laviaes

[y

YIUU LU ANIZL1 9N AN W LH

azaausu Undnwiunangy Muuanisdiuanzuifdesns Wudu Teeiisnisiamnsaiinla

v
v

91
1. L@nMUaNABIN1599AT Restrict Access > Aan Edit

2. @anden Edit settings

d @ fowiheunii2 2

1.  Tsunsululasvawdidnea (M
Tusunsulsznnla

2. mwasmslaguamwilulvdau o

Tn

& B oo o e
3. #8471 Microsoft Excel niuunni

i

Edit ~| JL

Edit settings

Move right

Hide
Duplicate
Assign roles

Delete
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CY

3. §ivhde Restrict Access Aanyu Add restriction...

¥ Restrict access

Access restrictions
Mone 3

Add restriction...

4. muruaguwuunisaeat Tund endieg1e msiruangulunisidideidediaiuingun lagadn

\don “Group”

Add restriction...

Require students to

Activity completion
complete (or not
complete) another
4 activity.
Group Allow only students who

belong to a specified
group, or all groups.

5. Mvuangufeanislidnde Activity 138 Resource

Access restrictions

Student | must % | match the following
@  Group | Choose.. % X [Piessaset
Choose...
(Any group)

Add restrictio Al

;

6. fwpIsiiuNgun1siUndie AanUa Add restriction... ing1de 4 war Uo 5 vieldengUiuung

° ] o
NUUAAIIULUUEUY 9 woNAINFULUU Group

Access restrictions

Student | must # | match the following

@ Group | Al = X

Add restr]ction.ﬂ
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7.

8.

o = A& o [
muuaReulunisuanwa Tund Anuadu

- must B804 AAeInsInuEeulunfrue

74

- any nuehs avfesnssiueulalaleulandeinmuuaniuans

>

S18avdunUY Activity %58 Resource gt

AIAMUANISUaRTLYaIinAnw luntnsedn fe

v =2 Y 1 Ao ¥ < v v ! 1 a £
UnAnwlildeglunquitivualiszanuisaneaiuiite wildaiunsandnidnly

o . ,
. @ Unfnwnluldeglunguidivualissladanuisaveuiiuiatevss Activity 3o

Resource onvuald

or

'H%tudent must
ﬁ

Group Al

match

Group Bl

L1

Add restriction...

any * | of the following

9. Aanyu Save and return to course Tunihyeivazuanguiuunuiimuall

1.

+ ® fowineunii2 & Edit ~ £,
.« Youbelongto Bl
1. Tusunsululaswanddnwa ( Microsoft Excel ) iulusunsulsznvla
< '3
A5 Export azuuutdulng Excel
I9A039n15 Download HAAZLUUINLUUNAZBULNIGE1LNTavnlA fadl
a =4 v Y .
AaNLARNIITaLUUNAEDU (Quiz)
+ @ wuuvnasudnis 2 Edit = £
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